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READ ME FIRST 

Welcome to Take Control of Apple Mail in Leopard, version 1.0, 
published in May 2008, by TidBITS Publishing Inc. 

Mail, Apple’s full-featured email application, is the most popular way 
for Mac OS X users to send and receive email. This book helps you get 
more out of Mail by explaining its most important features, providing 
useful tips, and solving problems. This book was written by Joe Kissell 
and edited by Tonya Engst. 

Copyright © 2008, Joe Kissell. All rights reserved.  

The price of this ebook is $10. If you want to share it with a friend, 
please do so as you would a physical book. Click here to give your 
friend a discount coupon. Discounted classroom copies are also 
available.  

Printing 
Although you may print this ebook on your own printer, you can also 
purchase a copy printed in a book-like form. To buy a print copy, click 
Print on the cover. 

Updates 
We may offer free minor updates to this book. To read new infor-
mation or find out about any new versions of this book’s PDF, click 
the Check for Updates link on the cover.  
On the resulting Web page, you can also sign up to be notified about 
updates to the PDF via email. If you own only the print version of the 
book, contact us at tc-comments@tidbits.com to obtain the ebook. 

Basics 
In reading this book, you may encounter a few unfamiliar terms  
and conventions. Please note the following: 

• Menus: When I describe choosing a command from a menu in 
the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 
message in Mail is “File > New Message.”  
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• Multiple ways to perform a command: You can perform 
many commands in Mail in more than one way—for example, 
using a toolbar button, a menu command, or a keyboard shortcut. 
In this book, for the sake of brevity, I mention only one way to 
perform each command. In general, I describe the most obvious 
way of doing things—toolbar buttons are easier to find than menu 
commands (as long as they’re in their default locations), and menu 
commands are more obvious than keyboard shortcuts—but choose 
whichever approach suits you best. 

• Customizing menus: If a menu command doesn’t have a 
keyboard shortcut listed, note that you can add your own shortcut 
in the Keyboard Shortcuts view of the Keyboard & Mouse pane 
of System Preferences. (Sadly, any keyboard shortcuts that you’ve 
assigned to the Message > Move To and Message > Copy To sub-
menus don’t work—but see Running Rules on Command for a 
workaround.)  

• Customizing toolbars: Remember that you can customize 
the toolbars for Mail’s various windows to your liking (adding, 
rearranging, or moving controls) by Control-clicking (right-
clicking) on a toolbar and choosing Customize Toolbar from 
the contextual menu. 

• Path syntax: I occasionally use a path to show the location of a 
file or folder in your file system. Path text is formatted in bold type. 
For example, Mac OS X stores most utilities, such as Terminal, 
in the Utilities folder. The path to Terminal is: /Applications/ 
Utilities/Terminal. The slash at the start of the path tells you 
to start from the root level of the disk.  

You will also encounter paths that begin with a tilde (~), which 
is a shortcut for the currently logged in user’s home folder. For 
example, if a person with the account user name joe wants to 
install fonts that only he can access, he would install them in his 
~/Library/Fonts folder, which is another way of writing 
/Users/joe/Library/Fonts. 

• Finding Mail’s preferences: I often refer to preferences in 
Mail that you may want to adjust. To display Mail’s preferences 
(not to be confused with the system-wide settings found in the 
System Preferences application), choose Mail > Preferences. 
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Within that window, click a button on the toolbar at the top to 
display a pane with that category of preferences. Instead of giving 
detailed directions each time, I use an abbreviated notation such 
as “go to the Junk Mail preference pane.” 

  
TIP To keep up-to-date with Mail-related tips and news, see Tim 

Gaden’s Hawk Wings blog at http://www.hawkwings.net/. The 
site also includes a long list of third-party Mail add-ons at 
http://www.hawkwings.net/plugins.htm. 
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INTRODUCTION 

Back in the days of Mac OS X 10.3 Panther, I noticed that a lot of 
people were having trouble with Mail, Apple’s descriptively named 
email program. I liked Mail, but I also realized that it had some sig-
nificant bugs and missing features, and was poorly documented. So 
I wrote Take Control of Email with Apple Mail to try to help people 
make the most of Mail. (I also wrote a companion volume, Take 
Control of Spam with Apple Mail 1, which dealt solely with junk mail; 
it’s still available separately.) When Tiger came out, it featured an 
entirely new version of Mail with many new features—and a long list 
of problems to match. So I once again got busy writing, this time 
producing Take Control of Apple Mail in Tiger. 

Now Mac OS X 10.5 Leopard is available, and along with it, the latest 
and greatest incarnation of Mail, version 3.0. And guess what? Once 
again, it has some significant bugs and missing features, and is poorly 
documented. What a surprise! Don’t get me wrong: I still like Mail a 
great deal, and I rely on it for my personal use even though I’ve tried 
every other Mac email program. It’s just that I’ve had to spend far too 
many hours figuring out how to do things that Apple didn’t bother to 
explain in the user interface itself, in the online help, or on the Web. 
So I’ve written this book in the hope of saving other people all that 
time and effort. 

This book is a no-nonsense guide to help you take control of a power-
ful email program without getting lost in extraneous information. I’ve 
worked hard to make it more compact and concise than Take Control 
of Apple Mail in Tiger, but without omitting any crucial information. 
To accomplish that, I’ve focused on the most important things that I 
think you need to know about Mail 3.x—I give little attention to either 
obvious, self-explanatory features or highly advanced topics (such 
as encrypting email and working with non-Roman alphabets). I do, 
however, occasionally refer you to articles elsewhere on the Web for 
more details about things I can only touch on here. If there are topics 
you’d like to see more about in a future edition of this book, drop me 
a line at jwk@mac.com and let me know. 

                                            
1 This link contains a $5-off coupon code. If you click it, and then click the 
Buy Ebook button, you should see the discount in the first screen of the cart. 
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QUICK START TO CONTROLLING APPLE MAIL 

You can read this book in any order you wish, though I recommend 
reading the background information listed under “Manage Mail 
setup” before proceeding with the rest of the book. 

Manage Mail setup: 
• Start on the right foot as you Learn What’s New in Leopard Mail 

(p. 7) and Learn about Email Protocols (p. 8). 

• Get Mail up and running in Set Up Your Accounts (p. 12). 

Read email: 
• Get mail into your Inbox; then sort it, read it, and work with it. See 

Read Incoming Messages (p. 16). 

• View RSS posts in Mail. See Read RSS Feeds (p. 30). 

Create email: 
• Make sure your messages get to the right destinations by reading 

Address Addressing (p. 33). 

• Get your message across with style (or even with plain text!). Read 
Compose and Send Messages (p. 39). 

Get organized: 
• Get a grip on the organizational tools Mail provides. See Manage 

Your Mailboxes (p. 53). 

• Track your tasks. See Keep Track of Notes and To Do Items (p. 55). 

• Find any message in a jiffy. See Find Your Messages (p. 62). 

• Keep your email consistent across Macs. See Synchronize Mail 
Data Using .Mac (p. 70). 

• Let Mail do tedious filing and sorting for you! See Automate Mail 
with Rules (p. 74). 

Make Mail work better: 
• Having problems sending, receiving, or searching email? Find a 

solution in Fix Mail Problems (p. 78). 

• Make sure you don't lose your valuable email. Learn how to Back 
Up and Restore Your Email (p. 89). 
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LEARN WHAT’S NEW IN LEOPARD MAIL 

The version of Mail included with Leopard (3.x) looks superficially 
much like the version that shipped with Tiger, but it has many 
changes. Among them are these: 

• Data Detectors: Automatically put contact and schedule info to 
use. See Use Data Detectors (p. 21). 

• Quick Look for attachments: Open many attachments 
instantly. Read Deal with Incoming Attachments (p. 23). 

• Junk mail filtering changes: Change when the Junk Mail filter 
runs. See Set Mail’s Junk Mail filter correctly (p. 27). 

• RSS support: Read RSS Feeds right in Mail (p. 30). 

• Forward as Attachment: Forward Messages as Attachments 
rather than as text (p. 49). 

• Stationery: Use Mail Stationery to create template-based 
messages such as newsletters (p. 50). 

• Rich text improvements: Read about new formatting options 
available in Handle Message Formatting (p. 39). 

• Photo browser: Attach photos from iPhoto. Read Learn 
attachment basics (p. 45). 

• Re-orderable sidebar: Move certain items up or down in your 
sidebar. See Arrange Your Mailboxes (p. 54). 

• Notes and To Dos: Keep track of all your reminders in Mail. 
Read Keep Track of Notes and To Do Items (p. 55). 

• Improved Spotlight searching: Find Your Messages more 
easily than before (p. 62). 

• SMTP server options: Read Pick a server (just one) (p. 83) to 
learn about Mail’s new SMTP options. 

• Time Machine support: Never lose a message! Read Back Up 
and Restore with Time Machine (p. 89). 

• Archive Mailbox command: Archive a Mailbox for long-term 
storage outside Mail (p. 91). 
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LEARN ABOUT EMAIL PROTOCOLS 

The word “protocol” may sound complicated, but it’s just a way of 
describing how your email program talks to a mail server. If you 
understand a few basics about email protocols up front, you’ll have 
an easier time understanding Mail’s interface and solving problems. 

Although you may not be aware of it, any email account involves 
two entirely separate systems—one for sending and another for 
receiving—and these often use entirely different servers. You probably 
use the same user name and password for each, but behind the 
scenes, each Mail account functions as two separate accounts: 

• Your incoming account fetches email from your mail server and 
delivers it to you using a mail delivery protocol—such as POP (Post 
Office Protocol) or IMAP (Internet Message Access Protocol). Just 
ahead, I explain more about POP and IMAP, and I mention a few 
quirks of .Mac and Exchange accounts. 

• Your outgoing account uses a mail transfer protocol called SMTP 
(Simple Mail Transfer Protocol) to send outgoing email from your 
machine to your mail server, and then (usually through a number 
of intermediate steps) to the recipient’s mail server. 

POP 
In a nutshell, a POP account works like this: First, your client (that 
is, your email program) asks the server for the list of messages in your 
Inbox. Then, depending on your client’s capabilities and settings, it 
downloads all the messages, selected messages, or all messages under 
a specified size, to your local computer. Finally (and optionally), your 
client instructs the server to delete its copy of some or all of the mes-
sages. The server does not store information about whether or not 
a message has been downloaded, read, or deleted; only your local 
client knows this, and the overall assumption is that you wish to read, 
organize, and store your mail on a single computer, using the server 
only as a conduit to receive it.  

However, you can usually leave messages on the server and then 
check your email with a different client (or on a different machine), 
but then all the messages will appear to be unread. 
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SET UP YOUR ACCOUNTS 

In Mail 3.x, account setup is as easy as it gets. You start in Mail’s 
Accounts preference pane by clicking the  button at the bottom. Fill 
in your name, email address, and password, make sure Automatically 
Set Up Account is checked, and click Create.  

Mail then attempts to figure out everything else it needs to know, 
such as your account type (POP, IMAP, .Mac, or Exchange), the names 
of your incoming and outgoing mail servers, and whether to use SSL. 
This works surprisingly well for most of the major email providers, 
including AOL, Yahoo!, and Verizon (see below for a further expla-
nation about Gmail). 

If Mail can’t figure out how to set up your account automatically, it 
does the next best thing, which is to run an assistant that walks you 
through entering your account details. As long as you have the basic 
setup information that every email provider supplies to its customers, 
you should be ready to go in under two minutes. 

Rather than walk you through every step of this self-explanatory 
process, I’d like to offer a few account setup tips, beginning with a 
special set of instructions for Gmail users. 

Use IMAP with Gmail 
If you have a Gmail account, Mail can check it—and it can even do 
the account setup automatically. But the automatic setup defaults to 
POP, whereas IMAP is generally a better way to access Gmail; with 
IMAP, you’ll be able to access all your messages both in Mail and on 
the Gmail Web site. To access your Gmail account via IMAP in Mail, 
you must first turn on Gmail’s IMAP support (if you haven’t already 
done so). To do this: 

1. Go to http://mail.google.com/, and log in if necessary. 

2. At the top of the window, click the Settings link. 

3. Click the “Forwarding and POP/IMAP” link. 

4. Select Enable IMAP and click Save Changes. 
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READ INCOMING MESSAGES 

No email-related task is more basic than reading messages that other 
people send you. In this section, I get you going with the basics and 
cover what I consider to be the most essential aspects of reading your 
email. Later on, I look at advanced topics that relate to reading mes-
sages, particularly Manage Your Mailboxes, Find Your Messages, and 
Automate Mail with Rules. 

Check Your Email 
Before you can read your email, you must download it (or some 
portion of it) into Mail so you can see that you have it. By default, 
Mail checks your active email accounts automatically when you 
launch the application and every 5 minutes thereafter. You can also 
retrieve email manually or change the automatic checking interval. 

To check mail manually, click the Get Mail button on the toolbar. 
To change the automatic checking interval, open Mail’s General 
preference pane and choose a new setting using the Check for New 
Mail pop-up menu. (I recommend the default, Every 5 Minutes, for 
most people with fast, always-on Internet connections. But if you get 
as much mail as I do, you might want to turn off the alert sound that 
plays when new mail arrives to avoid having constant interruptions. 
To do this, go to the General preference pane and choose None from 
the New Mail Sound pop-up menu,) 

Although you cannot adjust the frequency of checking for each 
account individually, you can exempt individual accounts from 
automatic checking. To do this, open Mail’s Accounts preference 
pane, select the account, and go to the Advanced view. Uncheck 
the box labeled Include When Automatically Checking for New Mail, 
close the window, and save your changes when prompted. Mail then 
retrieves messages from that account only when you check your mail 
manually or when another action, such as sending mail, triggers an 
automatic check.  

(Some IMAP servers, however, automatically notify Mail when new 
mail arrives, prompting it to download the messages immediately. 
If you want to disable this feature, go to Mail’s Accounts preference 
pane, select your IMAP account, and click Advanced; then uncheck 
Use IDLE Command If the Server Supports It.) 
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READ RSS FEEDS 

Starting with Tiger, Safari has been able to display RSS feeds, 
which many blogs, news sites, and other online publications use 
to distribute information on an article-by-article basis. But frankly, 
Safari was never a great RSS reader; it does the job, but not with 
the wealth of features or flexible interface of stand-alone RSS readers 
such as NetNewsWire (http://www.newsgator.com/Individuals/ 
NetNewsWire/, free). With Leopard, Apple has tried a different 
approach: putting RSS support in Mail. 

In principle, this makes more sense. Mail’s interface is better than 
Safari’s for displaying RSS feeds, and many of the tasks you perform 
in Mail (marking messages as read, searching, using smart mailboxes, 
and so on) can be done exactly the same way with feeds. Having spent 
several months giving Mail’s RSS capabilities a good workout, my 
opinion is that if I were stuck on a desert island with only Mail to 
meet my RSS needs, I’d manage, but I’d prefer a more capable tool. 

With that in mind, I want to provide a quick overview of using RSS 
in Mail. But if you read more than a handful of RSS feeds on a regular 
basis, I suggest you look seriously at NetNewsWire, because Mail is 
likely to prove unsatisfying. 

Configure Mail’s RSS Preferences 
Mail has three new feed-related preferences, all found in the RSS 
preference pane. Before adding any feeds, take a moment to set these 
preferences to your liking: 

• Default RSS Reader: When you click a link on a Web page 
to subscribe to an RSS feed (or when you click the RSS icon in 
Safari’s address bar), the application shown in this menu will 
display that feed. Oddly, the default RSS reader in Leopard is 
still Safari, even though Mail is much better. Unless you have 
a favorite third-party RSS reader, choose Mail. 

• Check for Updates: Choose the frequency with which Mail 
checks for new RSS articles. I suggest the shortest value, Every 
30 Minutes. (If at any time you want to force an immediate update 
of all articles, click on the pop-up Action ( ) menu at the bottom 
of Mail’s Viewer window—or Control-click (right-click) on the feed 
or mailbox icon—and choose Update All RSS Feeds.) 
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ADDRESS ADDRESSING 

You can create outgoing messages in various ways—by clicking New 
Message or Forward in the toolbar, for example, or by replying (see 
Reply to Messages). In every case, the message needs one or more 
addresses, which I discuss in this section. 

When addressing an outgoing email message, you can, of course, 
simply type email addresses into the provided address fields (To and 
Cc). However, you may wish to easily enter email addresses that you 
have not memorized and you may wish to display the hidden address 
fields, Bcc and Reply-To. In this section, I explain how to handle each 
of these addressing scenarios, and I discuss sending email to groups. 

At the end of this section, in Choose an Account to Send From, I look 
at how to change the address from which you send your message, 
something you’ll likely need to know how to do if you have more than 
one email account configured in Mail. 

Put Addresses in Address Book 
Mail relies on the system-wide Address Book to store frequently used 
email addresses. If you haven’t already filled in your Address Book 
with your most frequently used email addresses, consider doing so— 
it will make your life a lot easier. 

  
TIP To make an Address Book card for the sender of a message 

you’re viewing in Mail, choose Message > Add Sender to 
Address Book. 

  

Address an Email Message 
In Mail, you can address your email using the Address Panel (which 
provides a little portal to Address Book), or you can use Automatic 
Address Completion. In addition, if you work for a larger organiza-
tion, you may be able to access addresses from an LDAP server. 
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COMPOSE AND SEND MESSAGES 

After you open a new message window (for example, by clicking 
New Message in the toolbar) and address the message (covered just 
previously in Address Addressing), the rest should be a matter of 
filling in the text and clicking Send, right? Well, it can be…but you 
may want to know about some additional topics, which I cover in this 
section. Feel free to read these in any order: 

• “Handle Message Formatting,” next, discusses the use of plain 
versus formatted text. 

• Read Personalize Email with Signatures (p. 41) to understand 
Mail’s Signature feature. 

• See Work with Outgoing Attachments (p. 44) if you want to send 
files to other people. 

• Flip ahead to Reply to Messages (p. 48) for information on special 
options Mail provides when replying. 

• Forward Messages as Attachments (p. 49) discusses a new way 
Leopard Mail offers for forwarding messages. 

• Read Use Mail Stationery (p. 50) to learn about Mail’s templates 
for sending newsletters, announcements, and the like. 

  
TIP DRAFTS OF UNSENT MESSAGES 

As you compose a new message, Mail periodically saves a copy 
of the as-yet unsent email in the Drafts mailbox for the account 
selected in the Account pop-up menu. You can also manually 
save your message to the Drafts mailbox by clicking the Save 
as Draft button on the toolbar or choosing File > Save as Draft. 
Drafts then remain in the Drafts mailbox until you open them 
and click Send—or you manually delete them. 

  

Handle Message Formatting 
You can make sure that your messages arrive with the optimal 
formatting for your recipients by considering whether to use plain 
text or rich text, and by being aware of a few special formatting tips. 
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MANAGE YOUR MAILBOXES 

Each account in Mail typically has several mailboxes—basically folders 
for holding email—including In, Drafts, Sent, Junk, and Trash. You 
can also add your own mailboxes. Your mailboxes appear in the side-
bar, on the left of the main Viewer window. 

If you have more than one account, Mail consolidates all mailboxes 
of a particular type under a single icon in the Mailboxes category in 
the sidebar. For example, if you have three accounts, Mail displays a 
single Inbox icon; select this icon to list the incoming messages for all 
three accounts. If you click the triangle next to the Inbox icon, each 
account appears individually; click any one of these icons to display 
the contents of just that account’s Inbox. 

Special Mailboxes 
Five mailboxes that appear in most accounts—Inbox, Drafts, Sent, 
Junk, and Trash—have distinctive icons and behave differently from 
other mailboxes; I refer to these as “special” mailboxes. What makes 
them special is that Mail automatically stores messages in them when 
you take certain actions (such as sending or deleting mail): 

• Inbox: Every account has an Inbox, if nothing else; it’s the 
mailbox where new messages are delivered. 

• Drafts: Messages you’ve started, but not yet sent, are stored here. 

• Sent: When you send a message, Mail keeps a copy here for your 
future reference. 

• Junk: This mailbox is designated for spam. If you’ve enabled junk 
mail filtering and set it to Move It to the Junk Mailbox (in the Junk 
Mail preference pane), Mail moves messages marked as junk to 
this mailbox. If junk mail filtering is disabled or set to Mark As 
Junk Mail, But Leave It in My Inbox, the Junk mailbox will appear 
as an ordinary folder icon in your sidebar. (For more info about 
setting up junk mail filtering, see Stop Spam, earlier.) 

• Trash: When you delete a message, Mail can either remove it 
immediately or move it to a Trash mailbox. To make sure deleted 
messages go into the Trash mailbox, in Mail’s Accounts preference 
pane, in the Mailbox Behaviors view, select Move Deleted 
Messages to the Trash Mailbox. 
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KEEP TRACK OF NOTES AND TO DO ITEMS 

In recognition of the fact that may people use their email Inbox as a 
de facto to-do list, Apple added two related features to Leopard Mail 
that make it easier to manage tasks and other information without 
having to open another program—Notes and To Dos: 

Notes 
Notes can hold any sort of information (styled text, graphics, and so 
on) and are automatically stored in a special mailbox without your 
having to actually mail yourself a message; you can edit these notes 
whenever you want. Notes behave just like regular messages for the 
purposes of searching and smart mailboxes. 

Create a note 
To start a new note, click the Note button in Mail’s toolbar to open a 
new window that looks like a yellow legal pad (Figure 7).  

FIGURE 7 

 

The basic note window 
can hold any text you 
type or paste; you can 
also drag in graphics or 
other files. 

   
In the New Note window, type (or paste) anything you want—you can 
even drag in graphics and other files from the Finder. Here are a few 
quirky things that you might like to know about creating a note: 

• Dragged-in files: Just as with attachments, you can Control-
click (right-click) an added file’s icon to show a contextual menu 
that lets you choose whether to view the file in place or as an icon. 
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FIND YOUR MESSAGES 

Spotlight automatically indexes all your messages for super-fast 
searching. And with Leopard, Spotlight gains interesting new capa-
bilities in Mail, such as support for finding whole phrases enclosed in 
quotation marks and searching by date. Unfortunately, Leopard Mail 
also loses the capability of performing Boolean searches, though I 
describe another approach to achieving approximately the same result. 

  
NOTE SAVE YOUR EMAIL 

Quite often, someone writes to ask me for some information 
that I sent earlier—each time accompanied by the apology, 
“Sorry, I know you sent it to me, but I deleted it.” When this 
happens, I shake my head, sigh, and ask, “But why?” 
I know many people have the habit of deleting email messages 
as soon as they’ve read them. I applaud the tidiness such a 
habit lends to one’s Inbox, and I recognize that in some cases 
this habit was borne out of limited disk space or online mail 
storage. But look—it’s 2008. With modern tools, modern ultra-
large hard drive sizes, modern high-capacity email accounts, 
and fast Spotlight searching, you can afford to break this habit. 

  

Perform a Basic Search 
To find an email message, begin by (optionally) selecting one or 
more mailboxes in the sidebar in which you want to search. Then 
start typing in the Search field in Mail’s toolbar. (To jump right to 
the Search field, press Command-Option-F.) Mail begins displaying 
results in the message list immediately—sometimes even before you 
finish typing. To hide the results and return to the message list, click 
the  icon in the search box. 

  
TIP To quickly search for all messages from a given sender, drag 

any message from that sender into the Search field. Mail fills 
the From email address in automatically. 

  
Searches in Mail are insensitive to case, and encompass accented 
characters. For example, searching for ical will match iCal, and 
searching for creme brulee will match Crème Brûlée. 
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SYNCHRONIZE MAIL DATA USING .MAC 

If you have more than one Mac, and a .Mac membership, you can 
synchronize much of your Mail data across computers fairly easily. 
That word “much” requires some clarification. Account settings (such 
as mail server addresses, user names, passwords, and preferences for 
each account), notes, to do items, rules, signatures, and smart mail-
boxes all synchronize, as do your Address Book contacts. In fact, 
almost everything except—minor detail—your actual email messages 
can sync between computers. 

As a matter of fact, your email can remain perfectly in sync between 
computers at all times too, as long as you use exclusively IMAP, .Mac, 
and Exchange accounts—all of which store copies of your mail on a 
server—and have no “On My Mac” mailboxes. (This is what I do with 
multiple Macs, by the way, and this approach has worked remarkably 
well for me over—try it if you switch between computers frequently.) 

But if you use POP accounts, or if you move messages from IMAP 
servers to local mailboxes, synchronizing messages between com-
puters is much harder. The only reliable way to do it for two Macs 
is to quit Mail on both machines and then copy one Mac’s entire 
~/Library/Mail folder to the other’s. But doing so overwrites all 
the messages on the second Mac, which may result in lost data. 

Doing a bidirectional, message-by-message sync is possible but 
messy. You could use a synchronization utility (such as ChronoSync 
from Econ Technologies, (http://www.econtechnologies.com, $40) 
to synchronize the two computers’ ~/Library/Mail folders—but 
then both copies of the envelope index, which keeps track of which 
messages are where, will be incorrect. To fix them, you’d have to quit 
Mail, delete the file ~/Library/Mail/Envelope Index on each 
Mac, relaunch Mail, and let it reimport all your messages. Needless to 
say, that’s more bother than most of us want to go through regularly! 

  
TIP MAIL ON THE MAC AND THE iPHONE OR iPOD tOUCH 

For a detailed discussion of how to best read email in the Mail 
app on an iPhone or touch and in Mail on a Mac, consult Ted 
Landau’s Take Control of Your iPhone. 
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AUTOMATE MAIL WITH RULES 

Mail applies rules (sometimes called filters) automatically to incom-
ing messages. Among other things, rules can highlight messages or 
move them to specific mailboxes based on criteria like the name of 
the sender or the nature of the message content. For example, you 
can sort messages from mailing lists into a mailbox you only check 
when you have time, while highlighting messages from your boss 
in a special color.  

Because they are so powerful, rules are one of my favorite Mail 
features. The rest of this section includes a quick primer on creating 
rules, along with a few examples and tips. 

Create a Rule 
To create a basic rule, follow these steps: 

1. Go to the Rules preference pane and click Add Rule. 

A dialog appears showing the condition(s) the rule checks for and 
the action(s) Mail takes if the conditions match. 

2. Enter a name for the rule in the Description field. 

3. Set a condition to check for: Start by choosing something from the 
left-hand pop-up menu in this area; depending on what you choose, 
you may now see a second pop-up menu, a text field, or both. Here 
are some examples of a completed condition: 

[From] [contains] apple.com 
[Subject] [Begins with] Take Control 
[Date Sent] [Is Less Than] 3 days old 
[Message Content] [Does not contain] Leopard 

4. From the provided pop-up menus, choose the action you want 
the rule to perform on a message if (and only if) it matches the 
condition you just specified. Here are some examples: 

[Move Message] to mailbox: [Filed] 
[Set Color of Message] [of background] [Blue] 
[Reply to Message] (Click the button and fill in your reply) 
[Mark as Read] 
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FIX MAIL PROBLEMS 

As much as I love Mail, it does have its share of problems. Although a 
complete troubleshooting guide to Mail could run hundreds of pages, 
I’ve compiled solutions to some of the most common (and egregious) 
problems in the pages ahead, including difficulties receiving and 
sending mail, problems with damaged mailboxes, and misbehaving 
Spotlight searches 

Fix Incoming Mail Problems 
If Mail cannot download incoming messages, the cause may be 
anything from an incorrect setting in Mail, to a server problem, to 
a loss of Internet connectivity. Work through each of the following 
sections until you resolve the problem. 

  
TIP To see what Mail is doing behind the scenes, choose Window > 

Activity Viewer. A small floating window appears, displaying 
detail about each activity Mail is performing. To cancel any task, 
click the red “Stop” button next to it. 

  
Try Connection Doctor 
To open Connection Doctor, choose Window > Connection Doctor. 
In the Connection Doctor window, Mail lists every incoming and out-
going email account you've configured. It attempts to log in to each 
account, and if it fails with any of them, it displays an explanation 
as to why it failed. These explanations aren’t always helpful, but they 
often give you a good starting point in debugging problems, and are 
written in refreshingly plain English. If the Connection Doctor win-
dow suggests a specific fix, try that first. Otherwise, proceed with the 
following steps. 

User name and password errors 
If you enter your password in Mail’s Accounts preference pane, Mail 
stores the password in your Keychain (which is usually what you 
want). If, for security reasons, you prefer for Mail to prompt you for 
your password each time you connect, leave the Password field blank. 

Sometimes, even after successfully checking your email many times 
with the password you entered, Mail displays a dialog claiming that  
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BACK UP AND RESTORE YOUR EMAIL 

A number of years ago, my computer suffered a severe hard drive 
crash that wiped out years of saved email. At that time, I had not yet 
switched to IMAP, and I backed up perhaps once a year, so most of 
those messages were unrecoverable. The loss was devastating, but the 
shame was worse: I knew better than to put all my data in one basket, 
but I had done it anyway. I learned a valuable lesson, and today I back 
up my email (along with the rest of my files) religiously. If you back 
up your email properly, you can recover from nearly any disaster; if 
you don’t, your chances are slim. So please get in the habit of backing 
up your email regularly. 

Back Up and Restore with Time Machine 
Under Leopard, Time Machine is the easiest way to back up and 
restore all your data—including email. After attaching an external 
hard drive, you can turn on Time Machine (and, if necessary, select 
which volume to use and whether to exclude any files) in the Time 
Machine pane of System Preferences. With Time Machine running, 
your data is automatically backed up every hour, and you can go back 
to see how your Inbox (or another mailbox) looked at many points in 
the past. 

 To don’t: You can’t use Time Machine to restore to do items from 
within Mail, because they’re backed up as part of your iCal data. 

  
To restore messages or notes in Mail that Time Machine previously 
backed up: 

1. Navigate to any view in which the item you’re looking for should 
appear—say, your Inbox, another mailbox, or the Notes folder. 

 Not so smart: Time Machine doesn’t let you select smart 
mailboxes, though this may be a bug that will later disappear. 

  
2. Click the Time Machine icon in the Dock or choose Enter Time 

Machine from the Time Machine status menu on the menu bar 
(the menu first appeared in Leopard in Mac OS X 10.5.2). Mail 
becomes the center of the “time warp” screen. 
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ABOUT THIS BOOK 

Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. Keep reading in this section to learn more 
about the author, the Take Control series, and the publisher. 

About the Author 
Joe Kissell is Senior Editor of TidBITS, 
a a Web site and email newsletter about 
the Macintosh and the Internet, and the 
author of numerous print and electronic 
books about Macintosh software, 
including Real World Mac Maintenance 
and Backups (Peachpit, 2007), Take 
Control of Running Windows on a Mac, 
and Take Control of .Mac. He’s also a 
frequent contributor to Macworld.  

Joe has worked in the Mac software 
industry for over 10 years, including positions managing software 
development for Nisus Software and Kensington Technology Group. 
He also runs several blogs under the auspices of an Internet 
publishing business called alt concepts (http://alt.cc/). 

In his increasingly imaginary spare time, Joe likes to travel, cook, 
and practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke, 
and their cat, Zora. To contact Joe about this book, send him email 
at jwk@mac.com and be sure to include the words Take Control 
of Apple Mail in Leopard in the subject of your message. 
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Shameless Plug 
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